
TM

User Guide
Version 8.0 for Macintosh®

SUITCASE 8TM

ZM8-NAMAN-0499



© 1999 Extensis Corporation. This manual and the software described in it are copy-
righted with all rights reserved. Under the copyright laws, neither this manual nor the
software may be copied, in whole or part,without the written consent of Extensis
Corporation, except in the normal use of the software or to make a backup copy of the
software. This exception does not allow copies to be made for others. 

Extensis, the Extensis logo and Extensis Library are trademarks of Extensis
Corporation. Adobe Type Manager, ATM, and PostScript are trademarks of Adobe
Systems, Incorporated. Apple, Macintosh, PowerPC, AppleScript, and QuickDraw are
registered trademarks of Apple Computer, Inc. Netscape and Navigator are registered
trademarks of Netscape Communications. Microsoft and Internet Explorer are registered
trademarks of Microsoft Corporation. Symantec and Suitcase are trademarks of
Symantec Corporation. Quark and QuarkXPress are registered trademarks and
XTensions is a trademark of Quark, Inc. All other trademarks are the property of their
respective owners.

Extensis warrants the disks on which the software is recorded to be free from defects in
materials and faulty workmanship under normal use for a period of ninety (90) days
from the original date of purchase. If a defect occurs during the 90-day period, you may
return the disks to Extensis Corporation for a free replacement provided that you have
previously registered your product with Extensis Corporation. This warranty is limited
to replacement and shall not encompass any other damages, including but not limited to
loss of profit, and special, incidental, or other similar claims. This software is provided
on an “as is” basis. Except for the express warranty set forth above, Extensis
Corporation makes no other warranties, either express or implied, regarding the
enclosed software’s quality, performance, merchantability, or fitness for a particular
purpose.

Quark, Inc. makes no warranties, either express or implied, regarding the enclosed com-
puter software package, its merchantability or its fitness for any particular purpose.
Quark, Inc. disclaims all warranties of including, but not limited to, distributors and
retailers of Quark, Inc. software. Without limiting the foregoing, in no event shall
Quark, Inc. be liable for any special, indirect, incidental or consequential damages in
any way relating to the use or arising out of the use of the enclosed software. Quark,
Inc.’s liability shall in no event exceed the total amount of the purchase price/license fee
actually paid for the use of the enclosed software.

2

Extensis Europe
Zonnebaan 34
3606 CB Maarssen
The Netherlands

Telephone: #31 (0)30 247 50 50
Fax: #31 (0)30 241 20 39
E-mail: extensis@euronet.nl

Extensis Corporation
1800 SW First Avenue, Suite 500
Portland, OR 97201

Telephone: (503) 274-2020
Fax: (503) 274-0530
Technical Support: (503) 274-7030
E-mail: support@extensis.com
http://www.extensis.com

http://www.extensis.com


3

Introducing Suitcase 8 . . . . . . . . . . . . . . . . . . . . . .5
System and Software Requirements . . . . . . . . . . . . . . . . . . . . .5
Installation  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .5
Using this Manual  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .6
Registration . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .6
Technical Support  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .6
Using this Manual  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .6
Suitcase 8 Feature Summary  . . . . . . . . . . . . . . . . . . . . . . . . . .7
Suitcase 8 Utilities  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .8

Getting Started  . . . . . . . . . . . . . . . . . . . . . . . . . . .9
Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .10
To Open Fonts Using Suitcase . . . . . . . . . . . . . . . . . . . . . . . .10

Windows and Menus  . . . . . . . . . . . . . . . . . . . . . .12
Sets Window  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .12
Sets Window Info Panel  . . . . . . . . . . . . . . . . . . . . . . . . . . . .13
Fonts Window  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .14
File Menu  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .15
Edit Menu  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .16
View Menu  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .17

Show Open Fonts  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .17
Show Temporary Fonts  . . . . . . . . . . . . . . . . . . . . . . . . . . .18
Show Suitcase Fonts  . . . . . . . . . . . . . . . . . . . . . . . . . . . . .18
Show System Fonts  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .19

Tools Menu  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .20
Help Menu  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .20
Suitcase and Adobe Type Manager  . . . . . . . . . . . . . . . . . . . .21

Managing Fonts with Suitcase . . . . . . . . . . . . . . .22
Overview of Suitcase and Font Management  . . . . . . . . . . . . .22
How Suitcases Work  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .22
Kinds of Sets . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .23

Font Set . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .23
Application Set  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .23
Startup Set . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .23

One-time Temporary Fonts  . . . . . . . . . . . . . . . . . . . . . . . . . .24
Getting the Most From Suitcase  . . . . . . . . . . . . . . . . . . . . . .25
Creating Sets  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .25

To Create a Font Set  . . . . . . . . . . . . . . . . . . . . . . . . . . . . .26
To Create an Application Set  . . . . . . . . . . . . . . . . . . . . . . .27

Adding Fonts to Sets  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .28
Opening Fonts and Sets  . . . . . . . . . . . . . . . . . . . . . . . . . . . . .30

Contents



Managing Fonts with Suitcase (cont.)
Working with One-time Temporary Fonts  . . . . . . . . . . . . . . .31
Closing Fonts and Sets  . . . . . . . . . . . . . . . . . . . . . . . . . . . . .33
Renaming Sets  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .35
Removing Fonts and Sets  . . . . . . . . . . . . . . . . . . . . . . . . . . .36
Getting Information About Fonts and Sets  . . . . . . . . . . . . . . .37
Showing Font Status  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .38
Displaying Font Menus in WYSIWYG Format  . . . . . . . . . . .39
Specifying a Hot-key to Open Suitcase  . . . . . . . . . . . . . . . . .40
Warn Before Closing Items Preference  . . . . . . . . . . . . . . . . .40
Quit When All Windows Are Closed Preference  . . . . . . . . . .41
Font Conflicts  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .41

Warn When Fonts Conflict Preference  . . . . . . . . . . . . . . . .41
Preventing Font Problems when Sharing Documents  . . . . . . .42
Creating Empty Suitcases  . . . . . . . . . . . . . . . . . . . . . . . . . . .43

Automating Suitcase with AppleScript  . . . . . . . .44

Suitcase 8 XT  . . . . . . . . . . . . . . . . . . . . . . . . . . .48
How Can Suitcase 8 XT Help Me?  . . . . . . . . . . . . . . . . . . . .48
Installing Suitcase 8 XT  . . . . . . . . . . . . . . . . . . . . . . . . . . . .48
Using Suitcase 8 XT  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .49
Suitcase 8 XT Preferences  . . . . . . . . . . . . . . . . . . . . . . . . . . .50
Getting the Most from Suitcase 8 XT  . . . . . . . . . . . . . . . . . .52
Tips for Getting the Most from Suitcase 8 XT  . . . . . . . . . . . .54

Appendix A: Troubleshooting Suitcase 8  . . . . . . .55

Appendix B: Troubleshooting Suitcase 8 XT  . . . .58

4



Welcome to Suitcase™ 8! Suitcase 8 is a collection of powerful
font management utilities that make working with fonts faster and
easier than ever before. 

With Suitcase 8 you can group fonts and open them only when
you need them, saving valuable system resources. You can even
have Suitcase open fonts automatically when an application is
launched. 

Other tools in this valuable collection allow you to organize 
your fonts, prevent font conflicts, view fonts in font menus in
WYSIWYG format, and have missing fonts in QuarkXPress
documents opened automatically.

The Suitcase 8 collection includes: Suitcase 8, Suitcase 8 XT
(an XTension for QuarkXPress), Suitcase 8 MenuFonts, and
Suitcase 8 FontAgent.

System and Software Requirements

To install and use Suitcase, you will need the following:

Macintosh:
•   Macintosh® PowerPC® or compatible computer
•   4MB RAM, minimum
•   4.5MB free hard drive space
•   Mac OS® System 7.5.5 or later, including 8.6
•   To use Suitcase 8 XT: QuarkXPress, version 3.32 or higher
•   To use Suitcase 8 Online Help: Suitcase 8 requires 

version 4.0 or later of the most popular web browsers, such
as Netscape Navigator/Communicator or Microsoft Internet
Explorer.

Installation

You can find instructions for quick and easy installation on 
the CD-ROM that is included with your product or, if you
downloaded an Extensis product installer from our web site,
running the installer will place an informational Read Me on
your hard drive.
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Using this Manual

This User Guide covers Suitcase 8 for Macintosh and Power
Macintosh. When describing keyboard shortcuts, “z” refers to
the  or “command” key. References to menu selections are
shown as Menu > Command.

For a complete list of keyboard shortcuts, refer to the “Tips and
Shortcuts” section of Suitcase 8 Online Help.  

Registration

It is important to register your copy of Suitcase so we can provide
you with the best possible service. Registered users of Suitcase 8
are eligible for technical support, information regarding new ver-
sions and products, discounts and special offers on new products. 

Your registration number is located inside the CD package, or was
sent to you via email if you purchased through our website. You
will need to enter that number to personalize your copy of
Suitcase 8. 

If you choose not to personalize your copy, Suitcase will run in a
demonstration mode that allows you to use the product for 30
days. You can purchase this product in the US at 1-800-796-9798
or 1-503-274-2020. In Europe call 31 (0) 30 247 50 50.

Technical Support 

For questions regarding Suitcase, please first refer to this            
manual, which describes the features and basic operations. We
invite you to visit our Suitcase 8 page on the Extensis website
(http://www.extensis.com) for frequently asked questions (FAQs)
and troubleshooting tips.

If you have a question which is not addressed in this manual or
on the Extensis website, Technical Support is available by phone
at (503) 274-7030 Monday through Friday 8:00 a.m. to 5:00 p.m.
Pacific time. When calling for technical support, please be at your
computer and have the following information available: your
Extensis Suitcase 8 registration number, your computer configura-
tion and your question or a description of the difficulty you’re
experiencing—what specifically occurs and when. Take note of
any displayed error numbers or messages and any other informa-
tion you think may be relevant.

6

Tip

We can also be reached by:

Fax: (503) 274-0530
E-mail: support@extensis.com
Internet:
http://www.extensis.com/support

http://www.extensis.com
http://www.extensis.com/support
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Suitcase 8 Feature Summary

Suitcase 8 is an application and system Extension that together
allow you to group and open fonts only when you need them,
saving valuable system resources. 

The following list highlights some of the major features of
Suitcase 8:

• Drag and Drop—allows you to easily and intuitively manage
your fonts by dragging and dropping from the Finder, and
between Sets in the Suitcase window.

• Startup Set—allows you to specify fonts to be opened
automatically each time the system starts up.

• Application Sets—allows you to specify fonts to be opened
automatically each time a particular application is launched.

• Temporary Fonts—allows you to drag and drop fonts onto the
Suitcase application icon for immediate use, without creating
sets or adding fonts to a set inside Suitcase.

• Remote Access—allows you to open fonts on removable hard
drives and remote servers.

• Font status—allows you to easily see which fonts are currently
open and available to the system. You can also view lists of
System fonts, Suitcase fonts, and Temporary fonts.

• Font preview—allows you to preview font characteristics like
what the font looks like, and the name and path of any
associated printer font.

• Application—Suitcase is now an application rather than a desk
accessory, allowing you easy access to its many functions and
features.

• AppleScript—allows you to automate font operations using
AppleScript.

Font Compression Note: Suitcase 3.0 would compress screen
fonts upon request. Extensis has determined that this feature
caused font corruption and system crashes, and so has removed it
from Suitcase 8. Suitcase 8 will decompress any fonts that it
opens, and will store them as decompressed. There is no option
available from Suitcase 8 to re-compress these fonts.



Suitcase 8 Utilities

Suitcase 8 includes three additional utilities to make font
management even easier:

• Suitcase 8 XT: An XTension™ for QuarkXPress® that
automatically opens missing fonts using Suitcase 8. See
Suitcase 8 XT (pages 48 through 54) for details.

• Suitcase 8 MenuFonts: A control panel that displays font
menus in WYSIWYG format. See Suitcase 8 MenuFonts
Online Help for details. or refer to the Suitcase 8 MenuFonts
User Guide provided in Adobe Acrobat PDF format on the
Extensis CD.

• Suitcase 8 FontAgent: An application that helps you organize,
manage, and repair fonts, ensuring that your font library is
always ready when you need it. See FontAgent Online Help for
details.
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This section provides a brief overview of the most common
Suitcase functions so that you can get up and running quickly; for
detailed information on the many features available with Suitcase,
refer to other sections in this User Guide, and to the comprehen-
sive Suitcase 8 Online Help.

Open Suitcase by choosing “Suitcase”
from the Apple menu, or by double-click-
ing the Suitcase application icon. If the
Sets window is not visible, choose
“Show Sets” from the View menu.

A Sets window: This is the main
Suitcase window. Most operations
and functions can be accessed from
the Sets window.

B Status: Shows you instantly which
fonts and font sets are Open, Closed,
and/or Compressed. Also shows how
many items are in each set, and what
each item is.

C Sets: Allows you to create groups of font
suitcases (including folders of fonts) to
open and close at the same time. Click
the twisty arrow to expand or collapse
the list of items in the set. Create stan-
dard Font sets or Application sets; even
add items to the special Startup set so
that they open automatically each time
the system is started up. Drag and drop
items from one set to another.

D Info: Expand the Info panel to see
information about the selected item.

E Command buttons: Lets you quickly
create and add to sets, and open and
close fonts and sets. You can also drag
and drop font suitcases, and even folders
of fonts, into this window to automatically
add fonts or create new sets.

Suitcase Basics

Getting Started

D

E

B

A

C



Overview

To use Suitcase to manage your fonts you'll first need to create
"sets" for your fonts, add fonts to those sets, then open either
complete sets or individual suitcases within a set, so that the fonts
are available within your applications. When you are finished
using fonts or sets, simply open Suitcase and close the fonts, or
allow the fonts to be closed automatically when the system is shut
down or restarted.

You can create Font sets and add fonts at the same time by drag-
ging and dropping folders of fonts into the Sets window in
Suitcase, or you can use the "New Set" command or button to
create sets, then use the "Add..." command or button to locate and
add desired fonts to those sets.

You can have Suitcase open fonts automatically when the system
starts up by putting them in the Startup set. You can also drag
application icons into the Suitcase Sets window to create
Application sets. Fonts added to Application sets are opened auto-
matically when the application is launched.

Note: All fonts opened in Suitcase remain open until you close
them, or until the system is shut down or restarted.

To open fonts using Suitcase:

Note: The Suitcase extension is automatically activated when you
restart your computer after the program is installed. However,
until you actually add fonts to a set from within Suitcase and
“open” those fonts for use, Suitcase does nothing.

1. Open the Suitcase Sets window.

The Sets window is the main window in Suitcase.

To open Suitcase, choose “Suitcase” from the Apple menu,
or double-click the Suitcase application icon.

If the Sets window is not visible, open it by choosing
“Show Sets” from the View menu, or press z1.
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2. Create a font “set” and add fonts to it.

You can use the “New Set” and “Add...” buttons to create
sets and add fonts to them, or you can drag and drop
folders of fonts to automatically create a new set and
include the fonts inside the folder to the new set.

3. Open the set, or individual font suitcases in the set.

Select the sets and/or individual fonts that you want to
open (make available to the system and your applications),
then either double-click to open them, or click “Open.”

The fonts will be made available to your applications just
as if they were opened by the Mac OS from the Fonts
folder at start up time.

4. When you’re finished using a font or set of fonts, close
them to return the system resources to the system. Or
simply wait until the system is shut down or restarted,
at which time open fonts are automatically closed.

Select the sets and or individual fonts that you want to
close, then click “Close.” The fonts will be closed, and will
not be available for use in applications.

That’s all there is to it! Of course Suitcase offers numerous
functions and features to make opening fonts when you need
them as easy as possible, to ensure that font conflicts are avoided,
to allow you to preview fonts, view font status, and more. These
options are covered in detail in the following sections, and in the
comprehensive Suitcase 8 Online Help.
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All windows and menus are accessed from the Suitcase application. 

To open Suitcase: Choose “Suitcase” from the Apple menu, or
double-click the Suitcase application icon, or press the specified
hot-key (default is z-Option-S). 

Sets Window

The Sets window is where you create and work with Suitcase Sets. 

To open the Sets window: Choose “Show Sets” from the
Suitcase View menu, or press z1.

Windows and Menus

A Name: Displays name of item being
managed by Suitcase. Underline
shows which column the list is sorted
by. Click column title to sort.

B Size: Item size, or number of items in set.

C Kind: Set or item type. 

D Open: Solid bullet indicates that item is
open, or that all items in a set are open.
Hollow bullet indicates that some, but
not all, items in the set are open.

E Set: Allows you to create groups of font
suitcases or sounds (including folders of
fonts) to open and close at the same
time. Click the twisty arrow to expand or
collapse the list of items in the set.

F Application set: Allows you to create
sets of fonts or sounds that open
when the application is launched.

G Startup set: Allows you to automatically
open items or sets when the system is
started up. 

H Alias: In Suitcase, you can add sets to
other sets (Suitcase creates an alias to
the original set).

I Info: Provides access to additional
information about the selected font.

J Command buttons: Allows you to
manage fonts and sets. See page13.

K Hollow bullet: Indicates that some, but
not all, items in a set are open.

L Solid bullet: Indicates that the item is
open, or all items in a set are open.

Suitcase Sets Window

A

I

E

F

B C D

J

K
L

H
G
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Sets Window Buttons

A New Set: Click to create a new set.

B Remove: Click to remove selected items
or sets from Suitcase. Removing fonts
from Suitcase does not delete them from
the hard drive.

C Add: Click to locate and add items to
selected sets.

D Close: Click to close selected items or
sets. 

E Open: Click to open selected items or
sets.

F Application set: Allows you to create
sets of fonts or sounds that open
when the application is launched.

Info Panel

A Info: When expanded (by clicking the
arrow) provides access to additional
information about the selected font.

B Kind: Indicates item kind: Startup set,
Font set, Application set, font, or font
suitcase.

C Where: Displays the location (path) of
the selected item.

D Show: Click to open the fonts window
for the selected item. This button is
available only when an individual font
or suitcase is selected.

Sets Window Buttons and Info Panel

A

C

D

13

Sets Window Buttons

Info Panel (Expanded)

A B C D E

B
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The Fonts window lists fonts in different
ways (open, temporary, suitcase, and
system fonts), and can be used to dis-
play additional information about a
selected font. 

This window can be opened by clicking
the Show button on the Sets window, or
by choosing the appropriate item from
the Suitcase View menu: Show Open
Fonts (z2), Show Temporary Fonts
(z3), Show Suitcase Fonts (z4), or
Show System Fonts (z5).

A Selected Item: Some information
about the selected item is displayed
in the expanded Info panel. See also
page 15.

B Info: Expanded Information area. See
also page 15.

C Show button: Click to open the Fonts
window for the selected item. Note:
This button is available only when a
font or suitcase is selected.

Fonts window

D Fonts window pop-up menu: Choose
for display any of the following item
lists: all Open fonts, all Temporary
fonts, all Suitcase fonts, or all System
fonts. Note: You can also show any of
these items by selecting the appropri-
ate option from the View menu.

E Selected item: All items in a selected
suitcase are listed, and a sample of
the first item in the suitcase is dis-
played (see F through I).

F Sample Preview: When expanded,
shows a preview of the selected font.
Click the arrow to collapse or expand
the Sample Preview area.

G Printer font: For PostScript fonts,
displays the name of the required
printer font. 

H Font preview: Displays a sample of
the selected font in the size and type
indicated in I. You can change the
text in the Preview box by selecting it
and typing in the text of your choice.
Preview text is the same for all fonts.

I Size and type: Allows you to select
the size and type of the font sample
shown in the preview (H).

The Fonts Window

A

B

C

Sets window

Fonts window

G IHF
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File Menu

New Font Set

Creates a new, untitled font set in the Sets window.

New Application Set

Allows you to create an application set by locating the desired
application program in the Finder files and folder hierarchy.

Open Items

Opens the item(s) selected in the Sets window.

Close Items

Closes the selected item(s) in the Sets window.

Close Window

Closes the front-most open window.

Add to Selected Sets

Allows you to add items to the selected set by locating the desired
items on disk.

Add to Temporary

Allows you to open item(s) temporarily, without creating a set.
Temporary sets will be closed automatically when the system is
shut down.

Quit

Quits the Suitcase application.

Note: Closing the Suitcase application has no effect on the sets
and suitcases being managed by Suitcase.
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Tip

You can also create a new set by
dragging a font folder icon into the
open Sets window. 

You can create an application set
by dragging the application icon
into the open Sets window.

Tip

You can add items to any set by
dragging icons into the approp-
riate set from the open Sets
window.
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Edit Menu

Undo

Allows you to undo changes made when renaming a list item.

Cut, Copy, Paste, Clear

Available when a dialog box appears, and when you edit the
sample text in the font preview box in the Show Fonts window.

Select All

Choose all elements in a list or text box.

Remove Selected Items

Removes selected elements in a list or text box.

Preferences

Warn when fonts conflict: When two or more fonts have identi-
cal names, there is a "font conflict." In a font conflict the Mac OS
cannot determine which font to use and chooses arbitrarily. This
option allows Suitcase to notify you immediately when you open
fonts and one or more font names conflict with the name of a font
that is already open. When a font conflict occurs, Suitcase does
not open the conflicting font-instead it places a yellow caution
icon in the Sets window next to the font indicating that it conflicts
with another font. See also page 41.

Warn before closing items: Allows you to have Suitcase warn
you before closing items. Enable this option to keep you from
closing items accidentally. See also page 40.

Hot-key to open Suitcase application: Allows you to specify the
key combination for opening the Suitcase application. Default is
z-Option-S. See also page 40.

Quit when all windows are closed: Allows you to close the
Suitcase application when the last window is closed.  See also
page 41.

Tip

You can also remove selected
items by pressing the Delete key,
or by clicking the Delete button on
the Sets window.
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View Menu

Show/Hide Info

Show Info displays the Info area of the Sets window, or the
Sample area of the Fonts window. Hide Info collapses, or hides
this area.

Show Sets

Displays the Sets window. When the Sets window is open, this
menu item is dimmed.

Show Open Fonts

Displays the Fonts window, showing all the currently open fonts,
including those open in the System (fonts in the Fonts folder in
the System Folder), fonts opened by Suitcase (shown as a solid
bullet in the Sets window “Open” column), and any currently
opened temporary fonts.

Tip

You can also open the Sets
window by pressing z1.
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Show Temporary Fonts

Displays the Fonts window, showing only the currently open
temporary fonts.  

Note: Since Temporary fonts are not a part of a set, they do not
appear in the Sets window.

Show Suitcase Fonts

Displays the Fonts window, showing only the fonts being
managed by Suitcase. Suitcase fonts are shown whether they are
currently opened or currently closed.
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Show System Fonts

Displays the Fonts window, showing only the fonts found in the
Fonts folder of the System Folder. Tip

System fonts are opened by the
Mac OS when the system is
started up, but they are not
managed by Suitcase. To open
fonts at startup time but maintain
the ability to close and reopen
them as necessary, remove them
from the Fonts folder in the
System Folder and add them to
the Startup Set in Suitcase.
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Tools Menu

Use Local Font IDs

Restores the font IDs that were in use before font IDs were
imported.

Import Font IDs

Allows you to import Font ID files created previously with
Suitcase. A font ID is a number that uniquely identifies a font.
Font IDs and other resource IDs are used internally by the Mac
OS and other applications, including Suitcase. A font ID file con-
tains a list of every font and its corresponding identification num-
ber. Import font IDs in order to resolve conflicts that may arise
when using fonts from another Macintosh on your machine.

Export Font IDs

Allows you to create a Font ID file. A Font ID file contains a list
of every active font on your Macintosh and its corresponding
identification number.

Create Empty Font Suitcase

Allows you to create and name an empty font suitcase and place
it anywhere on your system or a connected network. You can then
place PostScript screen fonts, QuickDraw GX fonts, TrueType
fonts, or sounds into the suitcase. Items in a suitcase are referred
to by the Mac OS as one file.

Help Menu

Show/Hide Balloons

Enables Mac OS Balloon Help, which displays a descriptive text
balloon when you move the cursor over a menu item.

Suitcase Online Help

Launches Suitcase Online Help, a comprehensive, HTML-based
information system you can use while the Suitcase application is
open. Online Help will automatically open the system’s default
Web browser.

Tip

When you work with documents
created on another Macintosh
system, it can be helpful to import
Font IDs from the source comput-
er. This gives Suitcase a complete
profile of the font IDs it needs in
order to use fonts from that
Macintosh.
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Suitcase 8 and Adobe Type Manager™

Suitcase 8 works flawlessly with Adobe Type Manager (ATM).
However, some of the features in ATM Deluxe are also found in
Suitcase 8. This means that if you use ATM Deluxe, you will
need to replace it with the standard version of ATM.

To replace ATM Deluxe with ATM:

1. Obtain a copy of the Adobe Acrobat Reader in order to
get Adobe Type Manager. 

ATM is provided free from Adobe Systems, Inc. as part of
the standard Acrobat Reader installation. A copy of this
installer is located on the Extensis CD, inside the “3rd
Party Products” folder.

You can also download the Adobe Acrobat Reader installer
from the Adobe web site at: http://www.adobe.com

2. Run the Acrobat Reader installer.

A folder labeled “Adobe Acrobat 3.0” will be created. 

3. Inside the Acrobat Reader folder, locate Adobe Type
Manager (ATM).

4. Drag the ATM icon to the System Folder of your
startup disk.

This will replace ATM Deluxe with standard ATM.

5. Restart your computer to activate ATM.

http://www.adobe.com


This chapter explains how Suitcase uses sets to help you manage
your fonts, and shows you how to create and work with Suitcase
sets.

Overview of Suitcase and Font Management

If you haven’t used Suitcase before, you (like most Macintosh
users) probably have most of your fonts in your System Folder,
which means the Macintosh Operating System (Mac OS) opens
all of your fonts at startup time. This arrangement has some
advantages, because it means all your fonts are always open and
your applications can find any font at any time.

On the other hand, having every font open all the time can have
its disadvantages (especially if you have a lot of fonts) because
you probably have fonts open that you don’t need, consuming
memory and slowing down your Macintosh. Or, you may even be
at the point where you have so many fonts that the Mac OS sim-
ply cannot open them all, and you spend time swapping them in
and out of the System Folder.

Now that you have Suitcase, you can keep your fonts outside the
System Folder, yet easily open as many fonts as you want, any
time you want, without wasting precious system resources. You
can access the fonts conveniently, turning them on only when you
need them, then turn them off as soon as you’re finished with
them (or automatically the next time you restart the system) there-
by releasing system memory for other uses.

How Suitcases Work

To allow you to turn fonts on and off at your convenience, you
will create “sets” of fonts or font folders. A set is a list of the
fonts that you can open or close at the same time.

For example: You might create a set containing all of the fonts
that you need for a particular project. When you are ready to
work on the project, you can open the necessary fonts, all at the
same time, with just the click of a button. When you’re finished
with that project, you can close the fonts the same way that you
opened them. Or you can specify that a font set be an “application
set” in which case the fonts will be opened or closed
automatically when the system is shut down or restarted. 

Managing Fonts with Suitcase
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You can put fonts from local and/or remote drives into a set (as
long as the remote drive is available when you want to open those
fonts). Fonts that you put into sets in Suitcase behave as aliases of
the actual fonts on your hard drive. That is, when you add, copy,
move, or remove a font in a set, the actual font on your hard drive
is left unchanged. Besides font files, font folders, and font suitcas-
es, you can also put sound files into sets and open and close them
with Suitcase.

Note: If you move or rename the fonts in a set, you will need to
recreate the set using the new font name or location.

Kinds of Sets

Suitcase provides three different kinds of sets: Font sets,
Application sets, and the Startup set. 

Note: Fonts that you may want to use only one time can be
opened as “temporary” fonts, which do not need to be in a set. In
the case of temporary fonts, Suitcase will forget about them com-
pletely when you shut down the computer. See “Working with
One-time Temporary Fonts” on page 31.

Font Set: Font sets open fonts temporarily, but remain available
in Suitcase so that you can reopen them again at any time. When
you open the fonts in a standard Font set (as opposed to the
Startup set or an Application set) they stay open until you close
them, or until the system is shut down or restarted. Use Font sets
for fonts that are not specific to a particular application (see
below). These are the most commonly used sets.

Application Set: You can create Application sets for fonts that
you want Suitcase to open whenever you launch particular
applications. When an application set is opened, these fonts are
available to all other applications on your computer. When you
quit the application, the fonts in the application set remain
available until you close them in the Sets window, or until you
shut down your computer.

Startup Set: The Startup set is for fonts that you want Suitcase to
open automatically when you start up your computer. Any font
that you use all or most of the time should be placed in the
Startup set. The Startup set is a permanent set and it cannot be
removed (though it can be empty). You can add an alias of anoth-
er set to the Startup set. 
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One-Time Temporary Fonts

You can open fonts temporarily in Suitcase without placing them
in a Suitcase set. This allows you to quickly open fonts that you
will probably never use again.

Temporary fonts can be dragged and dropped onto the Suitcase
application icon, dragged and dropped into the “temporary” panel
of the Suitcase Fonts window, or opened using the “Add to
Temporary” command on the Suitcase File menu (zT). Fonts
that you add as temporary fonts are opened immediately, then
closed when the system shuts down or is restarted. Temporary
fonts will not reappear in Suitcase once they have been closed.

Getting the Most from Suitcase

To get the most from Suitcase, before you start using it you
should move most of your fonts out of the System Folder. This
might contradict what you’ve heard about fonts belonging in the
System Folder, but remember that Suitcase helps you conserve
system memory by opening fonts only when they are needed. To
do this, the fonts must be opened by Suitcase, not by the System.
Fonts left in the Fonts folder in the System Folder are opened
automatically by the System. To use Suitcase most effectively, we
recommend that you leave only the basic system fonts (which are
required to draw the desktop) in the Fonts folder inside the
System Folder. These fonts are: Charcoal, Chicago, Geneva, and
Monaco. All other fonts should be placed in another folder, and
opened using Suitcase.

To move the fonts out of the Fonts folder in the System Folder:
Create a new folder outside of the System Folder, then drag all of
the fonts (except Charcoal, Chicago, Geneva, and Monaco) out of
the System Fonts folder and into the new folder. 

For additional information on organizing fonts, see Suitcase 8
FontAgent Online Help, and visit the Suitcase 8 pages on the
Extensis web site (http://www.extensis.com).
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Creating  Sets

Although not required, another good thing to do before you start
creating sets in Suitcase is to group your fonts, as much as possi-
ble, into folders that reflect the way you think you’ll group them
into Sets in Suitcase. This is because you can easily create
Suitcase sets by simply dragging folders containing fonts into the
Suitcase Sets window.

You can still use and benefit from Suitcase without following this
suggestion, but since you’ll be finding and organizing fonts into
sets anyway, it makes sense to have them organized on your hard
drive as well. Then, besides having fonts that are easy to open
and use, they’ll be easier to locate on your hard drive, should you
ever need to.

For additional information on organizing fonts, see Suitcase 8
FontAgent Online Help, and visit the Suitcase 8 pages on the
Extensis web site (http://www.extensis.com).

Using Drag and Drop: You can easily create Suitcase sets and
add items to them by dragging and dropping them from the
Finder. Dragging and dropping within the Sets window allows
you to copy items or even entire sets into another set in Suitcase. 

To create a Font set:

1. Open Suitcase by selecting it from the Apple menu
(Apple menu > Suitcase), or double-click the Suitcase
application icon in the Suitcase folder.

If the Sets window is not open, select “Show Sets” from
the View menu, or press z1.

2. In the Sets window, click the “New” button.

A new font set appears and is assigned the name “untitled
set.” The name of the set is highlighted so that you can
easily change it.

3. Add fonts to the set by clicking the “Add…” button.

4. When you have selected the desired font(s), click
“Done.”

You can also drag fonts into the newly created set (see
“Adding Fonts to Sets” on page 28).
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— or —

1. Open the Sets window in Suitcase.

2. From the Finder, locate the folder containing the fonts
that you want in the set.

The folder can contain any combination of font files, font
suitcases, or sound files.

3. Drag the folder into the open Sets window.

A new set appears and is assigned the same name as the
dropped folder. The new set automatically contains all of
the fonts and sounds in the folder. The name of the set is
highlighted so that you can easily change it.
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To create an Application set:

1. Open Suitcase by selecting it from the Apple menu
(Apple menu > Suitcase), or double-click the Suitcase
application icon in the Suitcase folder.

If the Sets window is not open, select “Show Sets” from
the View menu, or press z1.

2. From the Finder, locate the application icon that you
want to create a font set for.

3. Drag the application icon into the open Sets window.

A new application set appears and is assigned the same
name as the dropped application icon. The name of the
new set is highlighted, allowing you to easily change it.

— or —

1. Open the Sets window in Suitcase.

2. From the File menu, choose “New Application Set.”

The Application Set dialog box opens, allowing you to
locate the desired application.

3. Locate the desired application, then click “Add.”

A new application set appears and is assigned the same
name as the selected application icon. The name of the
new set is highlighted, allowing you to easily change it.

4. Add fonts to the set by clicking the  “Add…” button.

5. Locate the font(s) that you want to add to the set, then
click “Done.”

You can also drag fonts into the newly created set (see
“Adding Fonts to Sets” on page 28).
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Adding Fonts to Sets

After a set has been created you can add individual font files, font
suitcases, and folders of fonts. You can even create sets to open
and close sets of sounds.

To add individual font files to Suitcase, they must be contained in
suitcases, and you must create a font set for them. You can drag
folders of font suitcases into the Suitcase Sets window to automat-
ically create a Font set containing the fonts in the folder. 

To add fonts to a set:

1. Open the Sets window in Suitcase.

2. Select the set that you want to add fonts to, then click
the  “Add...” button

3. Locate the fonts that you want to add to the set, then
click “Add.” To add all the fonts in a folder, click “Add
All.”

5. When you have finished adding fonts to the list, click
“Done.”

— or —

1. Open the Sets window in Suitcase.

2. From the Finder, locate the font or font folder that you
want to add to a set.
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3. Drag and drop the font suitcase or folder onto the icon
for the desired set.

Notes about adding fonts to sets:

• If you have a particular font in most or all of your sets,
consider adding that font to the Startup set instead, so that
Suitcase will open it every time you start your computer.

• Fonts added to the Startup set are opened the next time you
start your computer. If you have added fonts to the Startup
set you can open them manually (see “Opening Fonts and
Sets” on page 30), and thereafter have Suitcase open them
automatically the next time the computer is restarted. 

• Fonts added to an Application set are opened the next time
the application is launched and remain open until the
computer is shut down or restarted. You can open or close
these fonts manually at any time (see “Opening Fonts and
Sets” on page 30 and “Closing Fonts and Sets” on page 33).

• To display all the fonts in a set after you’ve added them, click
the arrow to the left of the set. This expands the set list and
allows you to work with individual fonts in the set.

• There is no limit to the number of font suitcases you can put
in a set.



30

Opening Fonts and Sets

You can manually open entire font sets or individual fonts in a set
at any time.

To open font suitcases or sets:

1. Open the Sets window in Suitcase.

2. Highlight the fonts or sets that you want to open, then
click the “Open” button.

— or —

2. Double-click the font suitcase or set icon.

A solid bullet (•) is displayed in the Open column for the
font(s) or set(s), indicating that they are open and available
to the system.

Notes about opening font sets:

• Suitcase opens fonts in the Startup set when you start up your
computer. Fonts in Applications are opened when you launch
the application. Fonts in standard Font sets must be opened
manually (or using AppleScript—see “Automating Suitcase
with AppleScript” on page 44). All fonts stay open until you
close them, or until you shut down or restart your computer.

• If an item is open, or when all items in a set are open, a
bullet (•) is displayed in the Open column for the set. When
some items in a set are open but others are closed, a hollow
bullet (°) is displayed. If an item, or all items in a set are
closed, no icon is displayed in the Open column. 

Note: A yellow warning icon ( ) in the Open column
indicates that the item or set was not opened because fonts
with the same name were already open on this system.

• Many applications automatically update their font menus
dynamically, which makes fonts that you open in Suitcase
available to the application immediately. For applications that
do not update their font menus dynamically, you will need to
quit and relaunch the application after opening fonts in
Suitcase.

• The Mac OS currently limits the total number of open fonts
to 342 (some of which are opened by the system itself). To
help stay within system limitations, Suitcase allows a
maximum of 300 fonts open at one time.
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Working with One-Time, Temporary Fonts

You might have some fonts that you use occasionally, but not
often enough to put into a Suitcase set (for example, fonts that
you need for a quick project, especially if they are located on a
remote or removable disk drive). You can open these fonts tem-
porarily without creating or adding them to a set. Suitcase closes
and forgets about temporary fonts when the system is shut down
or restarted.

To open a font as a temporary font:

1. In the Finder, locate the font(s) that you want to open
as temporary fonts.

2. Drag and drop the font icon(s) onto the Suitcase
application icon.

The font(s) will be opened automatically. 

— or —

1. Open Suitcase.

2. Choose “Add to Temporary” from the File menu (or
press zT).

3. Locate and add the desired fonts.

4. When you have finished adding temporary fonts, click
“Done.”

Tip

You can view the current list of
temporary fonts (if any) by choos-
ing “Show Temporary” from the
Suitcase View menu.
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— or —

1. Open Suitcase.

2. Open the “temporary fonts” panel of the Fonts window
by choosing “Show Temporary” from the View menu
(or press z3).

3. Drag and drop the desired fonts into the Temporary
panel of the open Fonts window.

To view the current list of temporary fonts:

1. Open Suitcase.

2. Choose “Show Temporary” from the View menu (or
press z3).
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Closing Fonts and Sets

You can close entire font sets or individual fonts in a set at any
time.

To close font suitcases or sets:

1. Open the Sets window in Suitcase.

2. Highlight the fonts or sets that you want to close, then
click the “Close” button.

All bullet icons will be removed from the Open column for
the selected fonts or sets, indicating that they are closed
and no longer available to the system.

3. If applications are running when you attempt to close
fonts or sets, a warning dialog will be displayed alerting
you that (depending on the application) the font names
may not be removed from application font menus. 

To close the fonts, click “Close Fonts Now.”

To cancel the operation and leave the fonts open, click
“Cancel.”
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To close a “temporary” font:

1. Open Suitcase.

2. Choose “Show Temporary” from the View menu.

The current list of temporary fonts is displayed.

3. Select the temporary fonts that you want to close, then
press the “delete” key.

A dialog box is displayed, asking you to verify that you
really want to remove the selected fonts from the list.

4. Click “Remove.”

Notes about closing fonts and sets:

• When you shut down or restart your computer, Suitcase
closes all font sets. Only the fonts in the Startup set are
reopened when the system starts up again.

• Closing an application linked to an Application set does not
close the fonts in the Application set. These fonts remain
open until the system is shut down or restarted, or until you
close them manually.

• When you close a font, the font is not removed from the
Suitcase set, nor is it removed from your Macintosh—the
font is simply being deactivated (made unavailable to the
system).

• You can specify whether Suitcase displays an alert box when
you close fonts. This “Warn before closing” option is
available from Edit > Preferences.

Tip

To bypass this warning dialog,
press Option-delete.
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Renaming Sets

To rename a Set:

1. Open the Suitcase Sets window.

2. Highlight the set that you want to rename.

3. Type in the new name.

4. Click anywhere in the Suitcase window outside of the
set name or icon.

The name is changed everywhere this set appears in
Suitcase.

Note: You cannot rename the Startup set, nor can you rename any
set that is inside another set (such as the set created when you
drag a font folder into an existing set).
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Removing Fonts and Sets

Note: You cannot remove the Startup set.

To remove a font or set:

1. Open the Suitcase Sets window.

2. Select the font(s) and/or set(s) that you want to remove.

3. Press the “delete” key.

A dialog box is displayed, asking you to verify that you
really want to remove the selected fonts from the list.

4. Click “Remove.”

The fonts and/or sets are removed from Suitcase. The
actual font suitcases on the disk are not affected.

Note: If any of the fonts that you are removing are
currently open, a warning dialog will be displayed
indicating that the fonts will remain open until the
computer is restarted. To avoid this issue, close the fonts or
sets before you remove them.

Notes about removing fonts and sets:

• When you remove a font from the Sets window, the actual
font on your hard drive is left unchanged.

• If you remove a set from the top level of the Suitcase Sets
window (that is, a set that is not a part of another set),
Suitcase removes that set and any aliases of that set in
Suitcase. However, if you remove an alias of a set (a set that
you copied into another set), the top-level set is not removed.

• When you remove open fonts or sets, Suitcase removes these
items from the Sets window, but the fonts remain open and
available to the system. In this case, the fonts are treated like
temporary fonts, and can be viewed in the “temporary fonts”
pane of the Fonts window.  

Tip

To bypass this warning dialog,
press Option-delete.
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Getting Information about Fonts and Sets

Without leaving the Suitcase application you can sort and preview
fonts, check font status, and play sound files. 

To sort fonts:

1. Open the Suitcase Sets window.

2. Click the column heading that corresponds to the
characteristic that you want to sort by: Name, Size,
Kind, Open, or Compressed.

Suitcase immediately re-sorts the list based on the selected
column.

To preview fonts:

1. Open the Suitcase Sets window.

2. Select the font that you want to view information
about.

3. If the “Info” panel at the bottom of the Sets window is
not visible, click the Info twisty arrow to expand the
Sets window.

A “Show” button is displayed on the right-hand side of the
Info panel.

4. Click the “Show” button to display information about
the selected font. 
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Showing Font Status

You can view information about particular categories of fonts in
the Fonts window: Open fonts, Temporary fonts, Suitcase fonts
(all the fonts being managed by Suitcase, whether they are open
or not), and System fonts (fonts opened by the Mac OS, not being
managed by Suitcase).

To show font status:

1. Open Suitcase.

2. Choose the desired category from the View menu, or
press the appropriate keyboard shortcut.

Show Open Fonts --> z2

Show Temporary Fonts --> z3

Show Suitcase Fonts --> z4

Show System Fonts --> z5

— or —

From the Suitcase Fonts window:

1. Select the desired category from the pop-up menu.



Displaying Font Menus in WYSIWYG Format

Note: Prior to Suitcase 8, the WYSIWYG Menus feature was a part
of the Suitcase application, and accessed from the Suitcase
Preferences window. This feature is now handled by the Suitcase 8
MenuFonts control panel.

You can display open fonts in the font menus of applications
(including Suitcase) in WYSIWYG format by enabling the
Suitcase 8 MenuFonts control panel. This allows you to see the
fonts "as they really are" so that font selection is easier. With
Suitcase 8 MenuFonts, you can also see immediately what types
of fonts are listed (PostScript Type 1 and Type 3, TrueType,
Multiple Master, Bitmapped), whether the associated printer font
(for Type1 fonts) is available to the system, and more.

Important: Suitcase 8 MenuFonts is not compatible with other,
similar, menu font utilities (such as Adobe Type Reunion and Now
WYSIWYG Menus). You must disable or remove these utilities to
use MenuFonts.

See Suitcase 8 MenuFonts Online Help, or the Suitcase 8
MenuFonts documentation in PDF format on the Extensis CD for
more information on this powerful utility.
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Specifying a Hot Key to Open Suitcase

You can specify a key combination to open the Suitcase applica-
tion. The default key combination is z-Option-S.

To specify a new hot key for Suitcase:

1. Open Suitcase.

2. Choose “Preferences...” from the Edit menu.

3. Verify that the “Hot Key to open Suitcase application”
box is checked.

4. Highlight the current key combination, then press the
desired keys. You can use the following keys: Option,
Control, or Command (z), along with any
alphanumeric key.

The following restrictions apply: The period (.) cannot be
used, Command cannot be used by itself, and any key
combination already in use on the Finder menu cannot be
used.

4. To close the Preferences dialog, click the Close button.

Warn Before Closing Items Preference

This preference allows you to have Suitcase warn you before
closing items. Enable this option to keep you from closing items
accidentally.

To enable or disable the Warn Before Closing Items prefer-
ence:

1. Open Suitcase.

2. Choose “Preferences...” from the Edit menu.

3. Check (put an “x” in) the “Warn before closing items”
checkbox to enable this preference.

Uncheck the box to disable it.
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Tip

You can turn off the hot key option
by un-checking the “Hot Key to
open Suitcase application”
checkbox. 
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Quit When All Windows Are Closed Preference

Allows you to have Suitcase quit automatically when the last win-
dow is closed.

Note: Quitting Suitcase has no effect on the opening or closing of
fonts.

To enable or disable the Quit When All Windows Are Closed
preference:

1. Open Suitcase.

2. Choose “Preferences...” from the Edit menu.

3. Check (put an “x” in) the “Quit when all windows are
closed” checkbox to enable this preference.

Uncheck the box to disable it.

Font Conflicts

When two or more fonts have identical names, there is a "font
conflict." In a font conflict the Mac OS cannot determine which
font to use and chooses arbitrarily. 

To prevent font conflicts, Suitcase will not open fonts when a font
by the same name is already open. Suitcase indicates fonts and
sets that were not opened by displaying a yellow warning icon
( ) in the Open column of the Sets window for the affected
fonts or sets. 

Warn When Fonts Conflict Preference

This option allows Suitcase to notify you immediately when you
open fonts and one or more font names conflict with the name of
a font that is already open. When a font conflict occurs, Suitcase
does not open the conflicting font—instead it places a yellow
caution icon ( ) in the Sets window next to the font indicating
that it conflicts with another font.

To enable or disable the Warn When Fonts Conflict prefer-
ence:

1. Open Suitcase.

2. Choose “Preferences...” from the Edit menu.

3. Check (put an “x” in) the “Warn when fonts conflict”
checkbox to enable this preference.

Uncheck the box to disable it.
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Preventing Font Problems when Sharing or
Transferring Documents

Sometimes fonts will display or print incorrectly after you have
transferred a document to another Macintosh, even when the fonts
appeared and/or printed correctly on the originating Macintosh.
This kind of font problem occurs when an application associates a
font name with an ID that is different between the two machines.
(Typically this happens only with older applications that still track
fonts by ID number; most applications today track fonts by name.)

Suitcase helps you avoid this kind of problem by letting you
export your font ID numbers into a Font ID file. You can then
import that Font ID file to another Macintosh running Suitcase. If
any applications on the destination Macintosh track fonts by ID
numbers, they will use the same ID numbers that your Macintosh
used, and thereby select the proper fonts for displaying and
printing.

To export Font IDs:

1. Open Suitcase.

2. Choose “Export Font IDs” from the Tools menu.

3. Locate the folder where you want the ID file.

The file will be named using the Macintosh owner ID
unless you specify otherwise before saving the file.

4. Click “Save.”

To import Font IDs:

1. Open Suitcase.

2. Choose “Import Font IDs” from the Tools menu.

3. Locate and select the desired Font ID file.

The file must have been saved previously from Suitcase
using the “Export File IDs” function.

4. Click “Open.”

To close an imported Font IDs file:

1. Open Suitcase.

2. Choose “Use Local Font IDs” from the Tools menu.

The imported Font IDs file will be closed and Suitcase will
return to using the machine’s own font IDs.
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Creating Empty Suitcases

Before you can add fonts to a Suitcase set, they must be in a suit-
case. However, you can add multiple fonts to any suitcase, and
doing so has distinct advantages. For example, the Mac OS treats
font suitcases as individual font files, not matter how many fonts
are in the suitcase. By organizing your fonts by suitcase, you can
increase the allotted number of fonts open at any one time.

To create a new suitcase you can use Suitcase’s “Create Empty
Suitcase” command, or you can duplicate or copy an existing
suitcase and then delete the fonts in the copy.

To create an empty font suitcase:

1. Open Suitcase.

2. Choose “Create Empty Suitcase” from the Tools menu.

3. Locate the folder where you wish to store the new suit-
case.

The suitcase will be given the name “Untitled” unless you
specify otherwise.

4. Click “Save.”



Suitcase allows you to use AppleScript to automate repetitive
Suitcase operations. For example, you can script Suitcase to
create sets from font folders on removable cartridges, or to
automatically compress all fonts. If you script Suitcase in
conjunction with other applications, you can create your own
custom Suitcase functions (such as to open a font set when you
open a particular document).

Note: Suitcase can be scripted, but not recorded or attached to an
application.

Object, Container, and Containment Hierarchy

The following concepts are vital to using AppleScript to automate
routine tasks and repetitive operations in Suitcase:

Object: An object is a piece of information you can manipulate in
Suitcase. And example of an object in Suitcase is a Font set in
which you place font files.

Container: A container is an object into which you can put other
objects. An example of a container in Suitcase is an Application
set.

Containment Hierarchy: The containment hierarchy describes
the relationship of one object to another, and the relationship of a
container to an object. In Suitcase, a containment hierarchy might
consist of font sets contained in Suitcase, font suitcases contained
in font sets, and fonts contained in font suitcases.

Using AppleScript Objects and Verbs

You can use AppleScript commands in the following way
(commands are listed in bold italic):

You can make these objects:
• Font set
• Application set

You can add these objects to an Application set or Font set:
• File
• Font file
• Font suitcase
• Sound file
• Font set

Automating Suitcase with AppleScript
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You can open, close, or delete these objects:
• File
• Font file
• Font suitcase
• Sound file
• Font set
• Application set

You can count or use exists with these objects:
• File
• Font file
• Font suitcase
• Sound file
• Font set
• Application set
• Window

You can get properties of these objects:
• File
• Font file
• Font suitcase
• Sound file
• Font set
• Application set
• Window

You can set these object attributes:
• File
• Font file
• Sound file
• Font set
• Application set
• Window

You can refresh displays.
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Displaying the AppleScript Dictionary for Suitcase

This section shows you how to list brief descriptions of the
AppleScript objects and verbs you can use to automate routine
and repetitive Suitcase tasks.

Note: You will need AppleScript Editor, which Apple provides with
AppleScript (or another script editor) to perform these steps.

To display the AppleScript dictionary for Suitcase:

1. Launch the AppleScript Editor application.

2. Choose “Open Dictionary” from the File menu. 

The Directory dialog box is displayed.

3. Use the pop-up menu to find and select the Suitcase
application.

4. Click “Open.”

The AppleScript dictionary for Suitcase is displayed.

5. Click the suite or suites about which you want
information.

6. When you have finished, choose Quit from the File
menu, or press zQ.

AppleScript Reference Books

The following books contain helpful information about using
AppleScript:

The Tao of AppleScript by Derrick Schneider (Hayden Books,
1994. ISBN 1-56830-115-4).

Danny Goodman’s AppleScript Handbook by Danny Goodman
(Random House, 1994. ISBN 0-679-7586-2) (currently out of
print, but copies may still be available).

Or visit the AppleScript website:
http://www.apple.com/applescript

http://www.apple.com/applescript
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Sample Script

The following is an AppleScript that illustrates some of Suitcase’s
scripting capabilities. The script below creates a Font set; adds a
font suitcase, a sound file, and an FKey file to the set; then opens
the set. It then creates an Application set; adds a font suitcase to
the set; then adds an alias of the Font set to the Application set.
Lines beginning with a double dash (--) are comment lines.

tell application ÒSuitcase 3.0Ó
-- create a font set named ÒSample SetÓ if it does

not already exist
if (exists of font set ÒSample SetÓ) is false then

make new font set with name ÒSample SetÓ
-- add a font suitcase to the font set
add font suitcase ÒHard Disk:My Fonts:GaramondÓ to
font set ÒSample SetÓ
-- add a sound file to the font set
add sound file ÒHard Disk:My Sounds:CrystalÓ to font
set ÒSample SetÓ
-- add an FKey file to the font set
add file ÒHard Disk:My FKeys:MouseFKeyÓ to font set
ÒSample SetÓ
end if 

-- open the font set
open font set ÒSample SetÓ

-- create a new Application set for ÒSimpleTextÓ if
it does not already exist

if (exists of application set ÒSimpleTextÓ) is false
then make new application set to file ÒHard
Disk:Apple Extras:SimpleTextÓ with name
ÒSimpleTextÓ

-- add some fonts to the application set
add font suitcase ÒHard Disk:My Fonts:Tekton PlusÓ
to application set ÒSimpleTextÓ
-- copy an alias of the font set ÒSample SetÓ to the

application set
add font set ÒSample SetÓ to application set
ÒSimpleTextÓ
-- delete a font suitcase from the application set
delete font suitcase ÒTekton PlusÓ of application
set ÒSimpleTextÓ
end if 
-- update Suitcase displays to reflect change
refresh displays

end tell



Suitcase 8 XT is an XTension to QuarkXPress that automatically
eliminates the tedious, time-consuming process of locating and
opening missing fonts by hand.

How Can Suitcase XT Help Me?

Suitcase 8 XT, combined with Suitcase 8, elimates the need to
locate, open, and manage missing fonts by hand in your
QuarkXPress documents.

With Suitcase 8 XT, when you open a QuarkXPress document
that contains missing fonts, Suitcase 8 XT automatically opens
them temporarily in Suitcase. You get the benefit of only using a
font when it is absolutely needed. Simply drag and drop your
fonts onto Suitcase and let Suitcase 8 XT do the rest. Font
management doesn't get any easier.

In an attempt to relieve the pain and burden of constantly opening
missing fonts, many users have resorted to adding seldom used
fonts to a permanently opened Suitcase set. However convenient,
dragging all those fonts around on the system slows down the
machine. The screen fonts within the permanent set get loaded
into memory every time you start up the machine. In addition,
utilities like ATM™ need a given amount of memory per font to
render them rapidly on the screen. ATM recommends 50k of
cache for each font size used. Over time, opening too many fonts
at one time can drastically effect performance. 

Installing Suitcase 8 XT

Suitcase 8 XT is installed automatically by the Suitcase 8
installer. If you ever need to manually install this XTension, drag
it to the XTensions folder located with the QuarkXPress
application.

Suitcase 8 XT
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Using Suitcase 8 XT

After installation, Suitcase 8 XT will automatically examine every
QuarkXPress document when you open it, and indicate if the
document contains missing fonts. If it does contain missing fonts,
Suitcase 8 XT will automatically search Suitcase for the missing
fonts. You will be given an opportunity to either open the fonts or
to replace them with different fonts.

If, for any reason, Suitcase 8 XT was unable to locate or open a
missing font within Suitcase, the following dialog will appear:

Note: You will be given a status for every unopened font: A status
of “Missing” means that the font was unable to be opened in
Suitcase. A status of “Duplicate” followed by a number means
that Suitcase 8 XT™ found more than one occurrence of a
missing font and is not sure which to open.



50

Suitcase 8 XT Preferences

When Suitcase 8 XT is loaded and QuarkXPress is running,
Suitcase 8 XT is added to the “Preference” sub-menu under the
QuarkXPress Edit menu. The following controls allow you to
customize how Suitcase 8 XT operates:

Quit Suitcase After Opening Fonts

With this option checked, Suitcase 8 XT will only open Suitcase
when needed. After it has finished opening the missing fonts, it
will close the Suitcase application.

If this option is not selected, Suitcase 8 XT opens Suitcase the
first time it is needed and leaves it open until the user selects the
Quit Suitcase option or manually quits the application.

Disable Suitcase 8 XT

By disabling Suitcase 8 XT, you can turn off the ability to have
the XTension automatically open missing fonts. This feature
allows you to enable and disable the XTension without quitting
QuarkXPress and removing Suitcase 8 XT. In this mode you will
still be notified of missing fonts and will have the ability to
replace any of those displayed.

Note: If you disable Suitcase 8 XT using the Quark XTensions
Manager (v4.0x), you will need to use the tools in QuarkXPress
to locate and work with missing fonts.
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Disable Font Replacement

This feature allows you to turn off the replace font functionality.
With the replace option disabled, Suitcase 8 XT opens missing
fonts at a drastically increased speed, however, it loses the ability
to determine if a missing font exists more than one time in
Suitcase. It will open the first occurrence it finds. If there are
fonts that are unknown to Suitcase, you will be advised to check
"Font Usage."

This feature should be used with extreme care. It allows users
who do not need the ability to replace missing fonts or determine
if Suitcase has multiple versions of a font name to open fonts at a
much faster rate.

Important: If you open a document which contains a font that
exists more than once in Suitcase with "Disable Font
Replacement" selected, Suitcase 8 XT will open the first
occurrence of the font name it finds.

Close Opened Fonts When Quitting

This option allows you to control what happens to the fonts that
were opened by Suitcase 8 XT. With this feature selected,
Suitcase 8 XT will close every font that it opened when the user
quits QuarkXPress.

If you leave this option unchecked, the fonts that Suitcase 8 XT
opened while using QuarkXPress will remain open on the system
until you restart your machine or you manually close them.

Open Fonts within EPS Images

This option allows you to instruct Suitcase 8 XT to open fonts
embedded in EPS images.
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Getting the Most from Suitcase 8 XT

Understanding Fonts

Understanding and setting up fonts correctly can help eliminate
all kinds of problems on a graphics workstation. All too often this
task is not taken seriously enough.

Font Fundamentals

Before we get into how-to tips for organizing your fonts we need
to cover the fundamentals. Fonts come in two basic format's,
TrueType and Type 1 (Postscript). It is important that you
understand the differences between these two types of fonts.

Here's how you tell the two types apart:

TrueType fonts contain the screen and printer information within
one file. If you double-click a TrueType font icon you will see the
window to the far right displaying the look of that particular type
face.

Type 1 (Postscript) fonts are separated into two different files for
every font—one for display on screen and another for the printer.
If you double-click a Type 1 screen font icon you will see the
window to the far right displaying the look of that particular point
size.

Getting Organized

The first step to organizing fonts takes place in your system's Font
Folder. Move all of your fonts out of the Fonts Folder and into
another folder on your hard drive. It is always a good idea to
allow Suitcase total control over which fonts are being opened on
the system.

Tip

Collect all the screen fonts for a
particular family together and
place them into one suitcase. If
you use ATM, you may also want
to consider only keeping the 10pt
and 12pt versions of each font. It
drastically cuts down on the size
of large font collections and ATM
is able to display the other sizes
correctly without every screen font
size.

Tip

If you reinstall your system for any
reason, always make sure that
another set of fonts were not
placed into the system "fonts"
folder. If you have any of these
fonts opened in a utility like
Suitcase, it will cause conflicts.
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Setting Up Font Folders

Create a separate folder on the hard drive for each font family.
Collect together all the different suitcases and printer fonts for
one particular font family. 

NEVER put more than one font family into a single suitcase.
However tempting, this practice only causes trouble finding fonts
later. This could also cause Suitcase 8 XT and Suitcase problems
trying to open a font within a suitcase that contains another font
name that is already opened somewhere else on the system.

Using the Startup Set with Suitcase 8 XT

Since you will be using Suitcase 8 XT to help automatically
manage the majority of missing fonts within documents, try and
keep the "Startup Set" down to a minimum. Opening a large
number of fonts permanently can seriously effect a workstation's
performance.

Tip

Place all the loose screen fonts
for a given font family into one
suitcase. If you are using Type 1
fonts, make sure that for each
style you have a screen font and
a printer font. Missing either one
can cause problems. Without the
screen font you will never have
the ability to choose that style
from the fonts menu, and without
the printer font you could choose
a font which will not print correctly.
Remove all unpaired fonts.
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Tips for Getting the Most from Suitcase 8 XT

How To Go Faster!

1. Disable font replacement. This will eliminate the need for
Suitcase 8 XT to determine if a font exists in Suitcase before
opening that font. It makes Suitcase 8 XT work about 3 times
faster.

Why Disable Font Replacement? The biggest reason is for
speed. By disabling this option, expect to go about 3 times
faster. Another reason is that you may not need that
functionality. If you do not have fonts in Suitcase with the
same name or do not need to replace missing fonts, you may
want to disable font replacement. Chances are you will never
need the added features that font replacement has to offer.

2. If you use ATM, reduce the number of screen fonts by
removing all screen fonts except the 10pt and 12pt versions for
each font. If a font doesn't have 10pt or 12pt, select the next
smallest size. Remove all others. This will reduce the number
of fonts that Suitcase 8 XT needs to search. If you remove half
of your excess screen fonts, Suitcase 8 XT will go about twice
as fast.

3. Keep the Suitcase Startup Set to a minimum. Adding a lot of
fonts that you use only occasionally to the startup set drags
down the systems performance. Try and keep the Suitcase
"Startup Set" to a minimum. If you like to use a certain group
of fonts but don't need them open all the time, try creating a
QuarkXPress document which contains your favorite fonts.
Store this away on your hard drive. The next time you want
those fonts, just open that document and let Suitcase 8 XT
temporarily open them for you.

Note: Some applications require that certain fonts be opened
whenever the application is opened. Suitcase 8 makes this easy to
do—simply create an Application set and specify the fonts to be
opened automatically whenever that application is launched.



55

Each Extensis product has extensive up-to-the-minute online help
and frequently asked questions (FAQs). Visit the Suitcase 8 page
on the Extensis web site for more information about Suitcase and
Suitcase 8 XT.

Suitcase fails to install

Restart your Macintosh, and as it restarts, press and hold the Shift
key to disable extensions.

Install Suitcase again.

Problems starting or using your Macintosh after Suitcase is
installed

Find and delete any extra copies of the System file and System
folder anywhere on your hard drive .

Rebuild the desktop.

Suitcase extension fails to load at startup time

If the Suitcase extension does not appear (or appears with an X
through it) when you start up your Macintosh, the Suitcase
extension may be in conflict with another extension, or may be
missing altogether. 

If the Suitcase extension is missing from the Extensions folder,
reinstall Suitcase.

However, if the Suitcase extension is present in the Extensions
folder, then a conflict may exist. Isolate the Suitcase extension
and see if the problem persists. 

If the problem goes away with other extensions disabled, there is
probably a conflict with another extension. You need will need to
isolate the conflicting extension using an extension manager like
Apple’s Extension Manager or Casady and Greene’s Conflict
Catcher.

Appendix A: Troubleshooting Suitcase 8

http://www.extensis.com
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A font in an Application set does not appear in the Font menu

If a font that you add to an Application set is not in the Font
menu when you launch the application:

1. Confirm that the font is inlcuded in the Application set.

If it is not, add it and relaunch the application.

2. If the fonts still does not appear on the Font menu, con-
firm that the font is open.

To see which fonts are open, open Suitcase to the Fonts
window “open fonts” panel (View > Show Open Fonts).

If the font does not appear on the open fonts list, open it
and relaunch the application.

3. If the font still does not appear on the application’s font
menu, drag the application’s Preferences file to the
trash, then relaunch the application.

4. If the font still does not appear, create a new one.

5. Drag the contents of the original Application set to the
newly created Application set. 

6. Find and make a note of any other sets that contain the
old Application set.

7. Delete the old Application set.

8. Add the new Application set to the sets you noted in
step 6.

9. Relaunch the application.

A font appears in the Font menu even after you remove it
from the Fonts folder in the System Folder

If a font keeps appearing in the fonts menu (and the font is not
Charcoal, Chicago, Monaco, or Geneva):

1. Search your Macintosh, including all font suitcases and
folders, for the font.

2. Drag all copies of the font to the trash.
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PostScript fonts that you add to your system do not display or
print correctly

If the PostScript fonts that you add to your system are not work-
ing correctly or causing your Macintosh to crash:

1. Do you have a copy of the PostScript fonts on disk?

If yes, try reinstalling the font from a master disk or a
backup. 

2. Do you have QuickDraw GX installed on your system?

If no, go to step 3.

If yes, convert the PostScript fonts to QuickDraw GX fonts
using the Type 1 Converter.

3. Is the problem limited to a particular application?

If no, go to step 3.

If yes, drag the application’s Preferences file to the Trash.

4. The problem may be being caused by an extension con-
flict. Try the procedures above under “Suitcase exten-
sion fails to load at startup time.”

If nothing listed here works, the font may be corrupt. Move
the screen font and the printer font to the Fonts folder in
your System Folder and test to see if it works in that loca-
tion. You should, if possible, reinstall the font from an orig-
inal disk and check with the font vendor to see if they have
a newer release of the font that is more compatible with the
newer computer operating systems.



Each Extensis product has extensive up-to-the-minute online help
and frequently asked questions (FAQs). Visit the Suitcase 8 page
on the Extensis web site for more information about Suitcase and
Suitcase 8 XT.

Suitcase 8 XT didn't open the font

Make sure that you only have one font family located in a single
suitcase. Having more than one font in a single suitcase can cause
a conflict. If Suitcase 8 XT tries to open a font within a suitcase
that contains another font name that is already opened somewhere
else on the system, the attempt will result in a naming conflict
and will not be allowed by Suitcase.

Suitcase 8 XT opened the wrong version of a font

If you have different fonts with the same name located within
Suitcase, do not disable the font replacement option. Under that
mode Suitcase 8 XT simply opens the first occurrence it finds of
a font, whether or not more exist in Suitcase. With font replace-
ment enabled, Suitcase 8 XT will determine how many times dif-
ferent fonts appear with the same name. Aliases are counted as
one. If Suitcase 8 XT locates a missing font name that appears
more than once, it will be displayed in the font replacement dia-
log with a status of “Duplicate” followed by the number of times
it was found.

Multiple documents didn't all open

Turn “Auto Picture Import” in the general preferences to either
“On” or “Off”. The “On Verify” dialog disturbs the opening
process. If you want to leave the “On Verify” option selected, you
must open each document individually. 

Appendix B: Troubleshooting Suitcase 8 XT
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